Learning - Solutions F' CAREEI{I—RACK.

(P PRY(OR  =FrepPryor SEMINARS

Microsoft® Excel®
The Basics

g ; . PRE-SEMINAR ACTIVITY

PRYOR

DISCLAIMER: Purchasers, readers, or users of this course agree to be bound by the following terms: Information contained in this course has been obtained by Pryor Learning Solutions from sources believed to be reliable. The subject
is constantly evolving, and the information provided is not exhaustive. The advice and strategies contained should not be used s a substitute for consulting with a qualified professional where professional assistance is required or Nl".llmlllmmm"”"""m""”m""
appropriate, or where there may be any risk to health or property. In no event will Pryor Learning Solutions or any of its respective affiliates, distributors, employees, agents, content contributors, or licensors be liable or responsible

for damages including direct, indirect, special, consequential, incidental, punitive, exemplary losses, or damages and expenses including business interruption, loss of profits, lost business, or lost savings. For purposes of illustrating HX71807A

the concepts and techniques describedin this course, the author has created fictitious names; mailing, e-mail, and internet addresses; phone numbers and fax numbers; and similar information. Any resemblance of this fictitious data

thatis similar to an actual person or organization s unintentional and purely coincidental.

©2018 Pryor Learning Solutions, Inc. Registered U.S. Patent & Trademark Office and Canadian Trade-Marks office. Except for the inclusion of brief quotations in a review, no part of this book may be reproduced or utilized in any form or by any means, electronic or mechanical,
including photocopying, recording or by any information storage and retrieval system, without permission in writing from Pryor Learning Solutions, Inc.



(@) i LR L e R

PRE-WORK PAGE

Getting Ready
What Are Your Excel Challenges?

1. Check all that apply

2. Rank the checked challenges from most to least important.

O Organizing data for the best results

Finding commands and tools in the Excel user interface
Slow and inefficient data entry
Data looks messy and is hard for others to read
Difficulty creating calculations and inputting formulas
Printouts are spread across too many pages and are hard for my team to read
Making sense of raw data to hand to decision-makers
Determining which charts or graphs will best illustrate my data

I o I o o I o I o O

Repeating the same simple tasks over and over

Set Goals
On a scale of 1-10, what is your current comfort level with Excel?
What are the one or two skills you most hope to learn (or challenges you hope to overcome) to increase your comfort level?

Understanding that this is an entry-level seminar, on a scale of 1-10, where do you hope to be at the end of the day?
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PRE-WORK PAGE

Get the Most Out of Your Seminar

Gather Data

What work do you usually do in Excel? (Example: mail merges, recording sales and calculating profits, charting trends, etc.)

How do you usually get your data into Excel?

A. Type it in one cell at a time

B. Receive complete workbooks from source (such as a Bank Account export or colleague)
C. Import data from external source (such as a shared database or website)

D. Copy/Paste from source

E. Other:;

Things to Bring

Do you often leave a seminar and on the drive home think“Rats! | meant to write down the instructor’s tips about printing?”
Try bringing specific questions and example “problems”to keep in mind as you participate so you won't miss or forget an
important tip you were looking for. Consider bringing one or more of the following:

» One or two pages of an existing Excel worksheet that you would like to improve

o Alist of the data you would like to organize into a spreadsheet (example: House Address, # of Bedrooms, Asking Price,
%Commission)

o A calculation that you are having trouble with (example: want to calculate amount of commission based on a home’s
asking price and %commission)

A series of steps you repeat frequently (example: highlight cells, bold text, change number format to %)

A list of questions you will be listening for answers to (example: How do | bold cell text?)

Identify and write down solutions to your example problems during the seminar.

©Pryor Learning Solutions + HX71807A 3
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PRE-WORK PAGE

Familiarize Yourself with Excel’s User Interface

During the seminar, you will be spending a lot of time immersed in Excel’s user interface at the guidance of your
experienced instructor. The more familiar you are with Excel’s main tabs and ribbons, the more you will get out of the
details that are presented. If you have time, complete the following practice tasks before you attend your seminar. Jot down
questions that come up as you complete the tasks and add them to your list of “answers you are listening for"above.

Explore Ribbons
= Open a new, blank Excel workbook
« Click on each tab. For each tab, find:
+ One group that you either use regularly and/or that you have never noticed before
- One button/feature that you either use regularly and/or that you have never noticed before

List one group | Example:
(new or Editing

familiar)

List one Example:

button Cell Style

(new or

familiar)

Explore Data Entry
» Type a number, a date, and a word into different cells. Observe how each is handled by Excel’s defaults.
» Enter any data into any cell and hit ENTER, repeat and hit TAB.

* Type a number with decimals into any cell (example: 1.02). Select the cell, then change the cell number format from
General to Currency, Percentage, and Text in turn. Observe the changes.

©Pryor Learning Solutions « HX71807A
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PRE-WORK PAGE

Explore Common Tasks

o Add a new worksheet to the workbook.

» Print any spreadsheet (with data) using only Excel defaults. Observe the page breaks, page orientation, and format (no
cell borders, for example).

* Save an existing file with a new name and in a different folder. Observe the steps in the Office Backstage. (Office
Backstage can be very different from version to version of Excel, so it will be helpful to be familiar with your version’s
Backstage before attending the seminar.)

» Change the color, font, or background fill of any cell that contains data.

©Pryor Learning Solutions + HX71807A 5
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Formulas
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A 1-\\9\00 - The strip of buttons and icons above the work area.

B /\Z..\AS' A collection of functionally- related controls and menus.
C Ly o\ Shed— An individual spreadsheet with rows & columns or a chart.
D WOKL 1600 A_ A file containing multiple worksheets.

E M G»F?/we,e, Marks the currently active cell or range.

F Tl -\ro»\a Provides access to options such as open, save, print, etc.

G B beose Talbes Stores shortcuts to frequently used features.

H Sm R Hosts specific shortcuts and information about a workbook.
I ’Z Oo Controls the magnification of the screen.

J Dm\c%._ Bow Liusehns Launches the associated dialog box.

K -%rmu.\«, Booue Displays the contents of the currently active cell.

L Mame o % Displays the name of the currently active cell.
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N

') The File Tab and Office Backstage

The File tab takes you to the Office Backstage where you will find all the tools you need to help you create [A],
save [B], print [C] and manage your workbooks. This is also where you can password protect your documents [D],
customize your copy of Excel [E] and prepare your documents for sharing [F1. Click the back-arrow to return to
your worksheet.

BookT - Excel Fred Pryor Seminars ? = O X
Protect Workbook Properties ~
} Control what types of fhangs Size Mot saved yet
Protect people can make to this workbook.

Workbook ~ Title Add a title

R
o Tags Add a tag

Categories Add a category

. @ - Inspect Workbook

Before publishing this file, be aware Related Dates

' Check for that it contains: Last Modified
Print Issues -  Author's name and absolute
b} path Created Today, 822 PM
Share Last Printed
Export ’~L' Manage Workbook Related People
Q Check out document or recover Author .
Publish Manage unsaved changes. Fred Pryor Seminars
Workbook ~ ] There are no unsaved changes. " *
Close Add an author

= Last Modified By 1ot caved yet
! Browser View Options

| Show All Properties
Account ‘ ] Pick what users can see when this
| Browser View workbook is viewed on the Web.
Options Options
Feedback
Book! - Excel Fred Pryot Semioars T - o x Feed Pryce Seminsis 7 - o %
Open Export
@ Recent Today [} Create POF/XPS Document Create a PDF/XPS Document
< A A—— % Preserves layout, formatting fonts, and images
a: ;,m':k(',,,‘.,,“,om,m_uw_ V2017 500 748 “ Content cont be easly changed
o OneDrive - Person! 5 [h chongefie Type % Freevemens e avadabie on the web
er
o Keywords /3072016 1:82 wne
] ThiskC o Sm:timplq«ﬁ%d)m: S HAM o=
n;\ Vieedy Report V2016 1035 AM POENPS
o Addapiace Sample Empioyee’s OneDr
7 Donor Thank You 17729 2
u = Sample Employee's OneDrive » Docu. MR
Browse g Donor Thark You SRS A

<l Sumple Employee’s OneDine » Docu.

Recaver Untaved Werkboas
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Save Your Workbook

Everyone has experienced the pain of losing hours of work because of not saving. The best way to prevent this
from happening is to save early - as soon as a new document is created, as this is what triggers the AutoSave
process to start — and often - each time a significant set of changes has been made.

Book1 - Excel Fred Pryor Seminars ? = m} X

]

Save As
L0

OneDirive - Personal

& OneDrive - Personal

’ Enter file name here

- ‘Excechrkbook('.xlsx) - 3 Save |
E‘; This PC More options... Vﬁ®, |

o |
@@ Add a Place =
- Name T Date modified

Browse Documents 10/3/2017 6:10 PM

Share @ Email attachments 1/4/2017 10:35 AM
Export .

Music 4/18/2017 2:24 PM
Publish

Pictures 7/12/2013 3:06 PM
Close

Public 7/12/2013 3:06 PM

=D

Account n;.};l Keywords.xlsx 6/28/2016 1:29 AM |

Options

Feedback -

1. Click the File tab.
2. Choose one of two options:
a. Click Save [A] to update your file with your most recent changes.
b. Click Save As [B] to save a new file or save an existing file in a new format.

3. Choose a destination for your file from the Places list [C] or browse the default folders list [D] or click Browse [E]
to open the Windows dialog box.

4. Choose a file type [Fl.

Excel 2007 and 2010: i Mac 2011 and 2013/365
1. Click the File tab (Office Button in Excel 2007). 1. Open the File system menu.

2. Choose Save or Save As to open the Windows 2. Choose Save or Save As from the dropdown
dialog box. menu.

©Pryor Learning Solutions + WX71802ES 3
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Customize the Excel Environment

Customize the QAT:
1. Click the Customize Quick Access Toolbar dropdown arrow [A].
2. Take one of three actions:

a. Select an unchecked item to add [B].

b. Select a checked item to remove [C].

c. Select the More Commands option [D] to view additional
options.

Customize the status bar:
1. Right-click the Status Bar [A].
2. Take one of two actions:
a. Select an unchecked item to add [B].

b. Select a checked item to remove [C].

%Q,\GHTIo"

Quickly access QAT commands by clicking ALT+(Number).

ribbon and populated with any available command or macro. To add a

H tab or group, select File > Options, then dlick the Customize Ribbon
control. Select any top level item and click the New Tab button to add a
tab, or the New Group button to add a group to that tab.

Q@u{q&
si~?  InExcel 2010 and later, custom tabs and groups can be added to the
B

—_
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() Seven Steps to Worksheet Success

Creating a worksheet can be frustrating and tedious, but following the Seven Steps to Worksheet Success can
minimize this frustration. There are exceptions to every rule, but using these steps — in order - as a guide will often
prevent wasted time and effort.

Design Build Calculate Format Report Print Automate

Before You Begin
Take some time to think about what your data needs to do and how it should look. Consider using a mind map.

Considerations:

1. Is Excel the right tool for this project?

2. What kind of data is being captured?

3. How do | want my columns & rows organized?

4. |s performing mathematical calculations on your data your primary purpose? (If not, strongly consider using
MS Access instead of Excel.)

©Pryor Learning Solutions - WX71802ES
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™
% Use a Template

Once you have answered the Before You Begin questions you are ready to design your worksheets. The fastest
way to get started may be to find a template that already meets all of most of your design needs.

1. Click the File tab.

(Office Button in Excel 2007) o T R
2. Select New[A]. @
Excel 2013-2016/365 o
1. Choose from Excel’s many built-in :&:,_: e ee———
Available Templates [B] or search for e A
more templates online using the search .
box [C] (internet connection required). R — e—c—— e—————

Click on a template to view more
information.

2. Click Create [D].

ARREERARRERRNEARNNTRN |

EXCEI 2007-2010 [ Inventory List R Inventory list with reorder

| highlighting

[
i

1. Click a template group option (Blank
workbook, Recent templates, etc.) or click
on a topic category under
Office.com Templates to browse and
download additional templates.

IR R R

RERSCUNEE AR AR TYNT
ERRRRRRR AR/

R AR AR REN RN RR] |

Pibiadiiag

2. Select the template you want to open.
3. Click Create.

B e e Sk 3 Bookt - Muroioft Bcelronommercsluse & e
Mome  lnset  Pagelayout  Formulss  Data  Review  View  Deseloper = s 0;;
: i Available Templatez Blank workbook
= < v @ Home [ _ﬁ
(5 open e |
Mac 2011-2016/365 o e , , ‘ B l
. o AR w & [
1. Open the File system menu. s moc | rem s wiewse tore |
2. Choose New from Template from the e , ! |
dropdown menu. gk i (e [ (e Ve | l
| |
. . el Anah Annual oy Yo Base Blue |
3. Select the template you want in the dialog o , 1
box. B | @ W (W (e , l
{ Budgets Busnerr  Caleuts Cha Daity :]

‘ Ll [ (S [ W [y
Excel 201 0 i DesignSets  Educstion  Employee [ Dpence )
Q | (L
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Enter Data

Type information in a cell:
: £ |

1. Selectan empty cell. — oL gl
' A BN Cc | D |

X
Januayr

W
w
4

1

2. Type the information.
3. Press the ENTER or TAB key on the keyboard.

|

Edit information in a cell:

(0, I S VU G T Y

1. Select the cell containing the information to be
edited [A].

2. Pressthe F2 key on the keyboard or double-click
the cell.

Uil

3. Make any needed changes.
4. Pressthe ENTER or TAB key on the keyboard.

Replace informationin a cell:

1. Select the cell containing the information to be replaced [A]. -
2, Type the new information.

3. Press the ENTER or TAB key on the keyboard.

Five things that can go in an Excel worksheet:

1.

2.

3.

8 ©Pryor Learning Solutions « WX71802ES
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{) Use the AutoFill Handle

Fill a series:

« Select a cell containing data that can be
used to fill a series [A].

e Left-click on the AutoFill Handle [B], then

drag up, down, left, or right to fill the series.

Fill a value:

1. Select the cell containing the value to be
copied [C].

2. Press and hold the Ctrl key on the keyboard.

3. While holding the Ctrl key down, left-click
and drag the fill handle left, right, up, or
down.

U
D S['?Jgo

s

I@I@I For more fill options, click the AutoFill
H - Options dropdown arrow [D].

November

December:

(N

December |January l?ggiﬁary March

February

March

|January

©Pryor Learning Solutions « WX71802ES
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Work with Cells, Rows, and Columns

Select cells, columns and rows:
» The SHIFT Key: Click the first cell, [A] then press and

é N

N

hold the SHIFT key while selecting a second cell [B]
to select all cells between the two.

The Ctrl Key: Click the first cell [C], then hold down
the Ctrl key while selecting additional cells [D] to
select individual clicked items.

Row or Column Headers: Click a Row [E] or Column
[F]1Header to select an entire row or column. Click
and drag across several Column or Row Headers

to select multiple rows and columns, or use the
techniques above.

The Sheet Selection Button: Select an entire
worksheet by clicking the Sheet Selection button
[G]. The same selection can be made by pressing
Ctrl+AA on the keyboard.

Other Options

CONTROL+ARROW: Jumps from the active cell to the last
entry in a column or row.

SHIFT+ARROW: Highlights one cell at a time in the
direction of the arrow.

Ctrl+SHIFT+ARROW: Selects an entire row or column
(stopping at blank cells j

Insert or delete rows or columns:

~ o v s

;0 @

12|
13
141

1. Select the rows or columns to be deleted, or the number of

rows or columns to be inserted [H].

2. Right-click any selected cell and select Insert or Delete [1].

10

Keyboard Shortcuts:
Cut» Ctrl+

Copy » Ctrl +

Paste » Ctrl +

Undo » Ctrl +

Redo » Ctrl +

11 | Atkins, Ron
12 ?Atkins, Ron
137jBarker, Bob
14 |Campbell, Mel
15 |Carrey, Barry
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4

Insert, Move, Copy, and Rename Worksheets

Insert a new, blank worksheet:

Click the Insert Worksheet button [Al.

Reposition a worksheet:

Left-click and drag the worksheet tab to a new location.

3|0 @~ m‘m-b‘wlN -

I

Move or copy a worksheet:
1.
2.
3.

Right-click the tab for the worksheet to be moved or copied [B].
Select Move or Copy [C] from the right-click menu.

Select the destination workbook for the moved or copied sheet from

the To book dropdown menu [D]. The current workbook is selected by

default.

Select the worksheet position in the destination workbook in the
Before Sheet pane [E].

Click the Create a copy checkbox [F] to create a copy of the sheet or
leave it unchecked to move the sheet.

Click the OK button.

Rename a worksheet:

1. Double-click the tab for the sheet to be renamed
[G].

2. Type the new sheet name [H].

3. Press Enter. ‘
1

To copy a sheet quickly, press and hold the Ctrl key while
clicking and dragging the sheet tab to new location.

©Pryor Learning Solutions - WX71802ES
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Formulas

Data calculation and analysis are the primary reasons to use Microsoft Excel.

Formulas are a key element in effective calculation, and understanding how they work is an integral part of getting
the most out of the program.

Rule #1: All formulas must begin with an equal sign (=).
Rule #2: Math in formulas is carried out left to right according to the “Order of Operations.”

| Funcion | Operator | ampleJpouerPhiase ]

Parentheses 0] 2*(3+2)=10 ‘D\tus‘{
Exponents A 3A2=9 E)cc,u.se
Multiplication * 3*2=6
Ty
Division / ‘D_e&“r-
Addition + 3+2=5 P
Subtraction - 3-2=1 50\.\\_,(
Which is the correct answer?
=5+6*10
110 or @

ARY /7,
f @/ . Calculate the answer to this problem using the Order of Operations.

i - =3+4+6%(4+2)/3-7

12 ©Pryor Learning Solutions « WX71802ES
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Formulas

Cells in formulas

When the value of a cell is used in a formula, it is called a C D E
“cell reference.” Cell references (or cell “addresses”) include
two components: a column reference and arow reference. 1 Amount 1 | Amount 2 Total
Column references are always letters, while row references i
are always numbers. 2 o 12 _ 6
The cell reference for the value “12” in the grid shown here 3 9 14
is C2.
4 18 2

R T e e e s D

In the same workbook, in the same a3 c3
worksheet
In the same workbook, but on a
’ | # d|
difforaneworkshaat Sheetname!C3 June Reports’!C3
In a different workbook [WorkbookName]lSheetnamel!C3 ‘[Q1_Sales]June Reports'IC3
Single quotes are needed if the name of the worksheet or workbook contains a space.

Use the “point & click” method to have Excel automatically
build your formulas with the proper syntax!

\@?
7 \cens Yo S el j:os‘w/&«s

\B?v* K 34 wols Qs C\(\(\K‘
’?_> Cbu\,\({,r\' 5\S\Mr, tordls 'LD 09“

ROOLsses
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/) Formulas

ARY Iz
( 2, Tothe rlg'ht are the prices of four products, & B C
the associated shipping charges, and the 1| TaxRate | 8 25%- ]
H tax rate. Create a formula in cell C4 that 2|

calculates the total price for each item, 3 Prices | Shipping |  Total
including tax and shipping. 4 $1200  $2.00
Note: Only apply the tax to the item price, not > | $15.00 $3.00
to the shipping 6 $18.00 ' $4.00

) 7 $25.00 $5.00

8

Formula:(_Px‘-‘l '%%S’.D/ ¥ Al’{ A+ (Bq‘

Relative Vs. Absolute Referencing

In the above example, an error would have been generated if AutoFill had been used to fill the formula to C5, C6,
and C7. The reason for the error is that Excel would have automatically converted cell B1 to B2, B3, and B4 in each
copied formula. In order to prevent a formula from adjusting its values in this way, the values must be formatted as
“absolutes.” To do so, “anchor” each reference with special syntax.

When a $ is applied to a cell reference, it has nothing to do with money. Instead, it becomes the anchor which
holds the value in place. The $ symbol tells Excel that the reference component to which it is applied should
remain unchanged. A $ may be applied to either or both components of a cell reference.

$B1 B$1 $BS1

14 ©Pryor Learning Solutions + WX71802ES
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Functions

Think of functions as task-based, pre-programmed formulas. Functions are always formatted as follows:

=FunctionName(arguments)

SUM - X« F =SUM(EZHZ

Example:

1=
m

SUM(numberl, [number?], ...) E
| | |

AutoSum

Sigma (Z), the mathematical symbol for summation, is known in Excel as AutoSum. Clicking it [A] automatically
inserts the Sum function to add a range of cells. Clicking the AutoSum dropdown arrow [B] provides quick access
to several key functions. AutoSums should be placed to the right and below data to be summed. AutoSum will not
include in the summed total the values of cells located to the right or below the cell where it is located.

Page Layout Formulas

| am—=) P2 < =
EEI; C L2 = D‘| . v
Paste i B I U- - DA EEE 3 = - § -9 s %2 g Conditional Formatas Cell Ei et 2 sum h
* - - ’ Formatting~ Table~ Styles~ [Z]Format~ Average
Clipboard Font ™ Alignment ] Number 5 Styles Cells Count Numbers ~
02 ~ fe o 3200 Max v
Min
A B c D E F G H -
i - = = Mere Functions.
1 |Company |FName [LName |Title QTR 1 QTR 2 QTR 3 QTR 4 Total
2 [J&d Jaime Swindell _ |Engineer $3,200.00 $4,391.00 $4,549.00 $4,707.00
3 |HILabs Mani Russo Manager $3,452.00 $5,674.00 $7,698.00 $9,722.00
4 |Jet Propulsion | Vicki Brannon VP Sales $5,467.00 $3,245.00 $4,532.00 $5,819.00
5 |Sun Systems  |Jernry Poe Exec. Director $4,568.00 $3,444.00 $2,198.00 $2.756.00
6 Kellog Lori Ann Palisi Sales Rep $9,830.00 $4,829.00 $3.,202.00 $2,003.00
7 GM Dave Thomas HR Director $1,256.00 $2,356.00 $4,555.00 $5,603.00
8 |Walmart Julie Schnelker |Buyer $2,343.00 $6,432.00 $2,523.00 $3,059.00
o Fort Knox Scott Foust Commander $7,897.00 $3,245.00 $5,093.00 $1,469.00

16 ©Pryor Learning Solutions - WX71802ES
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Functions

Create a Summary Sheet:

In this example, we need to add all four quarters for each state:

B C D E F G .8 c | D B |

3 First Quarter Sales l 3 | Year End Summary
4 January February March otal Sale 4 Grand Total Sales
5 | California | $1,345.00 | $2,345.00 | $4,567.00 $8,257.00 5 | California
6 | Florida | $3,333.00| $3,456.00 | $6,443.00 $13,232.00 6| Florida
7 | Georgia | $2,356.00 | $7,665.00 | $9,999.00 $20,020.00 7 Georgia
g | Indiana | $4,00000 | $4,444.00 | $5555.00 $13,999.00 8 Indiana

‘ Srunmr\ér»,'m First Quarter 757f_:ccnd Quaneri Ti;\;d «iuangr FounﬁQUanerri ‘7 . » Summary ] First Quarter ;econd duaﬁex |

For California’s total, we could write:
='First Quarter’!IF5+'Second Quarter’'!F5+'Third Quarter'IF5+Fourth Quarter’!F5

Or, Using 3D Referencing, we get this: =SUM(’First Quarter:Fourth Quarter’!F5)

Find More Functions: Insert Function ? X
Excel contains over 300 different Search for a funickion:
functions! Use fx on the formula bar to , _ e —— 1

. . P . . | Type a brief description of what you want to do and then | I Go l
display the full list which is organized | dlick Go ‘ =
b ca e or A . "";;l O P S ===

y b gory Or select a category: | Most Recently Used |~

Select a fundtion:

AVERAGE
IF
HYPERLIME

COUNT

IVIANX

SIM v

SUM({number1,number2,...)
Adds all the numbers in a range of cells.

Help on this function OK | [ Cancel

©Pryor Learning Solutions - WX71802ES
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Make Your Data Look Polished

Once all data and formulas have been entered, it's time to make the worksheet “pop” with color and pizzazz. A
clear, attractive, and professional-looking spreadsheet reflects well on the person who produced it. Many text
editing options are available on the Home tab.

File Home Insert Page Layout Formulas
o2 -
0 b Calibri AL R W W
Egy ~
Paste ¢ BIU- E- D-A- ===
Clipboard Font &

Live Preview enables you to see how a
new font, font size, table style, or cell style
would look on your selected data before
you actually apply it.

Select your text and mouse over various
formatting options in the Ribbon's menus.
When you see the formatting you desire,
just click the thumbnail to apply it.

Apply Cell Styles

Cell styles can save a lot of time when
formatting. When it comes to options,
there are many to choose from.

Format Cells ? X

Number Alignment  Font  Border Fill Protection

Text alignment Ornientation

Honzontal: &

| Center Across Selection vI Indent:
Vertical: \0 s
Justify dislributed
Text cantrol
§¥rap text
Shnnk to it
[ Merge cells

o
o
Ir=
@

2 | Degrees

Right-to-left
Text direction:
Context

]

Cancel |

18

View  Q Tell me what you want to do

geaCenter - § % 0 e T Syee Jiromae 2 ST? .
atling - Tabld tyles lter ~
Custem
BAKE... ContentsH.. Currency?  Cumency3 Currency Ex
Normal 2 Notrnal 3 Monnal 4 Normal_Ex Mormnal_Exce
Mormal_Exce Marmal_Pow Mormal_Sales
Good. Bad and Neutral
Normal Bad Geod Neutral
Tal’F Data and Model
Cleg[cicuiion | explanatory .. Hyperlink [1nput |
Dan Mot Warning Text
Titles and Headings
Pho Heading 1 Heading2  Headingd  Headinga Title
Mok Themed Cell Styles
20%- Accentl  20%- Accent2  20%- Accentd  20% - Accentd  20% - AccentS
40% - Accentl  40%-Accent2  40%- Accent3  40%- Accentd 407 - Accants
Safe e 60% - Accentd |
San—'! f iccens  Jaccents s
Number Format
O |= Comma Comma (0] Currency Currency (0] Percent
Peam we .
Virt rge Styles.

©Pryor Learning Solutions + WX71802ES

Select -

S Shate

Je)

Find &

Cuirency_Sales

Normal_Exce

Toal

20% - Accentt

40% - Accentt

Use the Dialog Box Launcher for more options under each
Ribbon Group. Excel’s dialog boxes provide access to many useful
options that are not available directly on the Ribbon.

Data Review View Q Tell me what you want to do
0 = § [~ P E“’ Insert ~
)~ = Wrap Text |General v = a5 :b.‘ -
Conditional F “J Cell Erdeee
§ E Mer e & Center ~ $ v 9% 9 ‘53 .qg onditional Format as € 5,
J ” Formatting~ Table~ Styles~ [ Format~
Alignment e Number 7] Styles Cells
File Home Pagelayout  Formulas:  Data  Review Vi Q Tell me what you want to do
L[ [itn  H -AN ==2 @ 14p Tea Setieial [j‘\il‘ TD [_‘l
Paste " Theme Fonts EfMergedCenter - § - % 3 %8 g Conditional Formatas Celi
O Cambria (Headings) , ) meal‘ing'k'fablc' Styles -
Cipboard & Gt ) Aignment o Number 5 Styles
Al Al Fonts
O Acumin Pro SemiCondensed Black
y O Adobe Devanagan o __Ci,f L _773 -
1 wLA 0 lymy® / ADDRESS CITY !
iRy, O ALGERIAN 3 W. Corinthians Way  Tarpon Springs
O Arial :
3 ‘B D —— 305 Ruth Dr. SE Clearwater
4 erO Al Natrow 32 Ephesians Blvd. Daman
O Arial Rounded MT Bold i i
5 ‘Lm O Avial Urico M3 16 Luke Circle Phoenix
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Copy and Paste Formats

Once a desired look has been achieved, it is easy to apply that same formatting to additional cells using a tool
called the Format Painter.

Copy or paste formatting from

one cell to another:
1. Select the cell with the e~ sptes-
formatting to be copied. ' -
Clipboard v
2. Click the Format Painter D E E G B
[A] button in the Clipboard 1 City State  Zip Phone
group on the Home tab. 2 | John 29 W. Corinthians Way  Tarpon Springs DE 24394 (850) 834-2459
3. Salaet the calls to which 3 Richard 8305 Ruth Dr. SE Clearwater PA 78667 (215) 733-6778
. 4 Robb 432 Ephesians Blvd. D FL 34698 (727)987-4445
the formatting should be © A aman GrET)
e 5 Doug 316 Luke Circle Phoenix AZ 19323 (459) 525-2945
PRIEC, 6 Sherry 235 Genesis Court Mobile AL 13924 (290) 733-7727

Copy or paste formatting several times:

1. Select the cells with the formatting to be copied.

2. Double-click the Format Painter [A] button in the Clipboard group of the Home tab.
3. Select the cells to which the formatting should be applied.

4. Repeat as many times as necessary.

5. Deactivate the Format Painter by pressing the ESC on the keyboard or by clicking the Format Painter
button again.

B C D E

L First |Address =~ |EEEEEEe1sY State
2 | John 29 W. Corinthians Way  Tarpon Springs DE
3 Richard 8305 Ruth Dr. SE Clearwater PA
4 'Robb 432 Ephesians Blvd. Daman FL
5 3Doug 316 Luke Circle Phoenix AZ
6 ' Sherry 235 Genesis Court Mobile AL

In 2007, Microsoft Office introduced the ultimate formatting feature
called Themes. Use Themes to create consistent document designs
across all Office products.

©Pryor Learning Solutions « WX71802ES 19



MICROSOFT EXCEL - THE BASICS

20

©Pryor Learning Solutions « WX71802ES



MICROSOFT EXCEL - THE BASICS

/, Organize and Display Data

There are various ways to organize and display data. The better organized it is, the more useful it will be to the
people who use it. Data formatted as a list are easy to read and understand, making that formatting choice ideal
for reports.

Seven Habits of Effective Lists:

Always create a Header Row.

Format the header row so it is easily distinguishable from the rest of the data.

Always build the list from top to bottom, not from left to right.

Do not include any entirely blank rows or columns in the data.

Use formatting to highlight portions of the data.

Do not merge cells within the list.

Be consistent - always use Delaware or always use DE, not a mix of the two.

Circle all of the things that need to be changed to correct this example:

-t |

O 0 N O 1 M W N —

- O

A B C
Ryan John 29 W. Corinthians Way
Ballard Richard 8305 Ruth Dr. SE
‘Wilmot Robb 432 Ephesians Blvd.
Lindt Doug 316 Luke Circle
Prindle Sherry 235 Genesis Court
Vickers Mark 112 Matthew Rd.
Perkins Joe 349 W. Sampson St.
Muhammad Rodney 7 Kings Hwy.
Karklins Maris 443 Titus Ave.
Rock Chris 31 Proverbs Place

D
Tarpon Springs
Clearwater
Daman
Phoenix
Mobile
Safety Harbor

San Francisco
Orlando
Pearly Gates
Virtuous Bay

©Pryor Learning Solutions - WX71802ES

E

Delaware

PA
FL
AZ
AL
LA

CA
FL
OH
MA

F
24394
78667
34698
19323
13924
46688

43733
34688
56932
09732

=
913-834-2459
(215) 733-6778
(727) 987-4445
(459) 525-2945
(290) 733-7727
(395) 785-6667

(656) 545-2345
(843) 734-9995
(909) 334-8721
(507) 288-3235

21
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Sort Data

Excel offers several ways to sort data alphabetically, chronologically, or numerically. The three most common are
listed below.

Method One:
1. Click a cell in the column by which the data should be sorted.
2. Click the A-Z[A] or the Z-A [B] button in the Sort & Filter group on the Data tab of the Ribbon.

File Home Insert Page Layout Formulas Data Review View Q Tell mewhat you want to do P+ Share
E F =) Show Queries IT Connegtiags. A 4'}@ 54 E]E EF Beo 3 P A7 & Group -
: < zZv |alz = . = v - - X
= mFrom Table 5 | Pr ’@v ) Reapply BB : = S Ungroup ~
Get External  New Refresh Z| Sort Filter Tetto . What-If Forecast __
Data - Query - DL Recent Sources All- o Edit L’Y Av Y Advanced Columns 55 = Analysis- Sheet ED Subtotal
Get & Transform Connection Sort & Filter Data Tools Forecast Qutline PR
Method Two: B e dre Bl gponife il oF ¢

DEPARTMEI A'{rial v:H) AN S % B
1. Right-click any cell in the column by which ]:ARC Vendol g | = 2. p-5i-%08 :E?;o:n:=T°t?£f§-"“““‘
the data should be sorted. Bolta o Lives : e

Vi
)

~~12000, 387
o X ca 12000, 511387 |
2. Select Sort[C]. ARG Copy
Ita Air Lines &y Paste Options:
3. Selecta sort method. A

— moo, sweo  soeon
‘Northwest Airlines 12000 52200 | $522.00
; D smart Lookup /20000  §78.85  §55200.

Insert...

Paste Special...

Method Three (Safest):

a A Lines

Delete... '2000 -

1. Click anywhere in the data to be sorted. IARC

:America West Aidir

Clear Contents

2. Click the big Sort button [D] in the Sort &

Fite 650 $16650

Filter group on the Data tab of the Ribbon. , - N e
< . . i s " 7l Sotatez
The Sort dialog window will open. T N - N P
3A§?° "E Format Cells... Put Selected Cell Color On Top
ARCT T bick From Drop-down List.. Put Selected Font Color On Top
COURTYARD BY '\' Define Name... Put Selected Cell Icon On Top
:Q.E.I.'.Cf‘_ei,’ Lines B Hyperlink. Custom Sert...
Pa¥.¥nllaala |\ E—
Sort ? X
Some sort methods allow you to sort a [ "3l Add Level | [ X Delete Level | [ By Copy Level | ?7 Z[ Options... | [ My dota has headers
COIumn by Itse“:' Column Sort On Order
Sort by lVendor I |Values @I lA toZ ]

Develop the habit of always saving at least
two copies of your very important files
justin case one copy gets destroyed by
incorrect sorting, random corruption, or

Oﬁ l Cancel

gets misplaced.
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Hide Data

Itis possible to hide data in a worksheet to simplify viewing, select a subset of data for printing, or to prevent

unauthorized users from seeing particular information.

Hide columns:

1. Select the columns to be hidden.
2. Right-click the selection.

3. Select Hide [A] from the menu.

A | B C D F | G
il Last Name First Name | Annual Salary Email Street Address City
2 |Brown Angela $  47000. i -4 - A A §-9 'Rd Overland Park KS
3 |Douglas  Serena $ 52000, B T o Ao m s £ Leawood KS
4 | Smith James $ 35000. LA* 0 22 siaway  Olathe KS
s [Wilson  Andy '§  67,000.00 | awitcan@hiz cam 307 NE 2nd St Leawood KS
6 |Franklin Edna '$ 52000 &% Cut n 3200 Texas Hill Rd. Raymore MO
7 |Rory Hawkins $  33000. G Copy 3623 W. 76st Independence MO
s [Johnson Kim ) 45,000. ~, Paste Options: m 601W. A . 2 0 . " 2 d LS
o |Quinn Aidan $ 52000 : 6092 E ! Last Name First Name Emll StretAddress City State
d $ 28000 ] 6230 V 2 |Brown Angela abrown@biz com 109Av1ngto_n Rd Overland Park KS
io|Berry Andy 7 < 3 [Douglas Serena sdouglas@biz.com 1307 S. White Leawood KS
11| Crocker Becky $ 33000 a m 684 Fo 4 |smilh James jsmith@biz com 1631 Andalusiaway  Olathe KS
12 |Rose Amy g 52]»000_‘ Insert 7419 T 5 |Wilson Andy awilson@biz.com 307 NE 2nd St Leawood KS
3|Ki il 000. slete . 6 |Franklin  Edna efranklin@biz.com 3200 Texas Hill Rd. Raymore MO
: gursge” E\nn g ;g’%g Delet gg;‘ ‘g/‘ 7 |Rory Hawkins hrory@biz.com 3623 W. 76st Independence MO
= S VAR Clear Contents B € 5 |Johnson  Kim kiohnson@biz com 601 W. 66th Terr Independence MO
15 s 3 [Quinn Aidan aquinn@biz.com G092 E 108th St N.  Leawood KS
Format Cells... -
16 10|Berry Andy aberry@biz com 6230 Valley Rd Independence MO
= Celumn t.n,’idth.‘@ 11 |Crocker Becky berocker@biz com 684 Fox Court East#B  Overland Park KS
L Hide s 12 |Rose Amy arose@biz com 7419 Terrace Raymore MO
8 B : e o h 13 | Kirby Bill bkirby@biz com 944 Walnut Ave Sunnyvale CA
19 Unhide 14| Russell Ann arussell@biz.com 967 Perreira Drive Raymore MO
—
A 8 D E F G .
M Last Name [First Name Email Street Address i Unhide columns:
S Cront e P 10 Aultnton Bl Overiand Fark Ko 1. Select the columns before and
3 |Douglas  |Serena Calibri - 114 - A A7 $-9% » BF Leawood KS . .
2 | Smith James BI=Mn-A- -<® ¥ way Olate KS after the ones which are hidden.
5 |Wilson Andy QEISUIWLIZ LU OV L £ DL Leawood KS . s .
o [Frankin  |[Edna "200 TexasHilRd.  Raymore MO 2. Right-click and select Unhide [B]
7 |Rory Hawkins S 623 W. 76st Independence MO from the menu.
= Copy
s [Johnson  |Kim | ;Cp’ ) 01 W. 66th Terr Independence MO
© |Quinn Aidan 0 PeteOptons 092E109th St N.  Leawood  KS
10|Berry Andy O 230 Valley Rd Independence MO
11| Crocker Becky Paste Special... 84 Fox Court East#B Overland Park KS
12 [Rose Amy e 419 A £ & 2 W - S
" = nser
13| Kirby Bk e sl $ bi (@bi remess" Ovi l KS
Delete 2 B abrown 1Z.com vington ‘erian ar <
1jRussel 1S R ol $ 5200000 sdouglas@bizcom |1307 S. White Leawood  KS
2 e 4 $§  35000.00 jsmith@biz.com 1631 Andalusia way ~ Olathe KS
16 [E Eormat Cells... 5 |Wilson Andy §  67,000.00 awilson@biz.com |307 NE 2nd St Leawood KS
17 Column Width 6 |Franklin Edna $ 5200000 efrankin@biz.com |3200 Texas Hill Rd. Raymore MO
= T 7 |Rory Hawkins  §  33000.00 hrory@biz.com 3623 W. 765t Independence MO
18 Hide 2 |Johnson  |Kim § 4500000 kohnson@biz.com |601W. 66th Terr Independence MO
e Unhide o [Quinn Aidan $§  52000.00 aquinn@biz.com 6092 E 109th St N Leawood KS
20 S Reiviove Liualinks 10|Berry Andy § 2800000 aberry@biz.com 6230 Valley Rd Independence MO
21 A EEMOVE RYPEriinks 11|Crocker  |Becky $  33000.00 berocker@biz.com |684 Fox Court East#B Overland Park KS
| 12|Rose Amy $ 5200000 zrose@biz.com 7419 Terrace Raymore MO
13 | Kirby Bill $  75000.00 bkirby@biz com 944 Walnut Ave Sunnyvale CA
14| Russell Ann $ 3200000 arussell@bizcom |967 Perreira Drive Raymore MO
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/) Filter Data

AutoFilter:
1. Click any cell in the data.
Click the Filter [A] button in the Sort & Filter group on the Data tab of the Ribbon.
Click the dropdown button at the top of the column to be filtered.

Choose a sort button [B] (A-Z, Z-A) or uncheck all but the desired entries from the Filters window [C].
(Uncheck Select All to clear all checks.)

Click the OK button.

2.
3.
4.

5.

24

Home

Get Bxternal  pew

Data ~

Insert

Page Layout

Farmulas

Review

View Q Tell m

F Show Queries ’T‘H 2] Connections sl [Z]2 Y Clear
5 7~ Z )
F=] From Table & 2] Properties AL V= Reapph
Refresh Z| Sort Filter
Query - D}j. Recent Saurces All - Edit Lin = T, Advanced
Get & Transform Connections Sort & Filter
A | B | C | D | E | F
1 DEPARTMENT TRAVEL EXPENSES
2 [Passenger Name ] Vendor [+| Depart'~| Return ~| Tax ~[TotalFa~
3____Adan¥ h 8l SortAtoz 5/15/2016 $10.00 :  $27.00
4 |Adamddomn z| soi7404 5/15/2016:  5/20/2016: 511387 = $569.36
5 |Adams Jim , 1/27/2016 $10.00 : 54500
6 | | o 5/16/2016 $10.00 | 527.00
7 |Adams, Jim = 5/15/2016 5/20/2016; $113.87 $569.36
8 |/ i 2/23/2016 $10.00 . 527.00
S |Atkins, Ron Text Filters » 2/23/2016 2/24/2016 $82.00 $82.00
10 | == - 2l 2/23/2016 2/24/2016:  $522.00 $522.00
11 {Campbell, Me L ‘ 5/12/12016 5/19/2016 $78.85 $552 00
> | i (5eled Al s 512/2016 51000 54500
— % AirTran Ainwvays, Inc.
13 |Carrey, Barry el 5/12/2016.  5/19/2016;  $78.85 ' 555200
[v] America West Airlines 5/12/2016 $10.00 545.00
5 |C American Airlines K© 5/11/2016.  5/18/2016:  $63.21 .  §372.50
16 |Chile, Juan :ﬁjget 5/11/2016 $10.00 . 527.00
7|C Continentalifines 3/6/2016;  3/7/2016;  $5100: 55100
18 |Conelly, Doug COURTYARD BY MARRIOTT 3/6/2016 $10.00 $27.00
[ Delta Air Lines " 3/6/2016;  3/7/2016.  S75.00 575.00
Conelly, Do T - 3/6/2016:  3/6/2016; $253.00 |  §253.00
21 g [ ok || cancer | 3/7/2016;  3/8/2016:  $88.00:  588.00
22 |Conelly, Doug 3/7/2016 3/8/2016 $79.00 $79.00
23 |Conelly, Doug USAIr 3/7/2016 3/7/2016: 3148 50 5148 50
24 |Conelly, Doug ARC 3/8/2016 3/8/2016:  $166.50 $166.50
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Create Charts

Sometimes data is better expressed visually
than by the numbers themselves. In those
cases, use a chart or a graph.

Create a chart:

1. Select the cells which contain the data

to be charted.
Click the Insert tab.

Click the dropdown arrow for the
desired chart type and then select a
sub-type [Al

2.
3.

OR

Click Recommended Charts [B] to

open the Insert Chart dialog box for
recommendations or a list of all charts
available in your version. (Excel 2013 and
later).

After you select your data, click
the Quick Analysis tool [(] to
quickly choose from Excel’s chart
recommendations or open the
Insert Chart dialog box. (Excel
2013 and later)

Formul

Page Layout

Q Tell me what you want todo

8 Share

B ® 3 _gp WER T a2 B & 4 o
2 " . 2D Column ) e
ables Illustrations Fecommended sarklines Filters Hyperlink  Tet  Symbols
Charts I r ""'j 0 imn[ g - - -
b Ao HH
81 ¥ fe | 3-DColumn
=N B_| 6 H LI A [N, S
@
a
g g E
= > e > E) ‘3
1 al = 3 3 & &
2 |Rent 595 595 595 595| 595 595
3 |Savings 400 400 400 400 400 400
4 |Credit Card 750 594 915 798 755 702
5 |Car Payment 369 369 369 369 369 369
6 |Monthly Cash 350 {4l Moe Gatasin Chars 360 520 320 360 280
7 |Electiic Bl e s 71 87]  102] 135 99
8 |Carlnsurance 135 135 135 135 135 135 135 135 135 135
9 |Cell 62 62 52 69 62 62 62 76 52 87
10 |Cable 50 50 50 50 50 50 50 50 50 50
11 |Phone 36 36 36 36 36 36 36 36 36 36
Insert Chart ?
Recommended Charts  All Charts
#  Clustered Bar
Budget
Tl | 1 : f
—
/ ] ] 1o 1.500 n 00 0
- / A clustered bar chart s used to compare values across a few categories,
e, / Use it when the chart shows duration or when the category text is long.
. v
[ concel |
A | B C D E F G
9 |Cell 62 62 62 69 62 62
10 |Cable 50 50 50 50 50 50
11 |Phone 36 36/\( 36 36 36 36
12 [Expense Total 2834 =172N=72.994] 2.786] 2.676] 2,772
L=
13
1
1 Formatting Charts  Totals Tables Sparklines
{ \ -
{m B O 12
1 Clustere... Clustere... More.
4
4
Recommended Charts help you visualize data.

=]
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{

Chart Types and Terminology

Chart Types

Column Radar

Insert Chart

Pec ded Charts Al Charts

Line Treemap

Recent

Pie Sunburst

Templates

lh| (8H (BA

Column

Bar Histogram

Line Clustered Column

Pie Budg

Area

Box & Whisker

Bar

Area

XY (scatter) | Waterfall

ALY (Scatter)

sk ‘Ill-!.'?rr‘

Stock Funnel

Surface

Radar

Surface Combo

Treemap

Sunburst

Chart Terminology

Histogram
Box 8 Whisker
Waterfall
Funnel

Combe

FAEEFOEXQERB Mo FE

oA 107 H0

Cancel

S - 0Oa : Chart Tools Fred Pryor Seminars [ = o X
File Home  Inset  Pagelayout  Formulas  Data  Review Format  Q Tell mewhat you want to do
P - . o en] T
1w Tl iilii ” il E B o (@
Add Chart Quick Change i, i ERE.. M1 SwitchRow/ Select  Change  Move
Element - Layout = Colors - Column  Data  ChatType Chart
Chart Layouts Chart Stytes Data Type Locstion ~
Chart2 - i v
A B Cc D F G H L M N [e] 41}
== 6} e et s s e B — - 1 S p—
sl Budget x‘ ;
| o | 4= 1l
| k-] & i
] L 5 ugudget 5 |
2 Rent 595 200 — Tiag|
3 |Savings 400 700 6,400|
4 | Credit Card 77N\ ) 595 9,397]
5 |Car Paymenl AF ! oo 4,428]
6 Monthly Cash 3t o 300 4,140
7 |Electric 87| | £ 400 1,165)
8 |Carlnsurance 135| ¥ O gy I 1,620] |
9 Cell 62 460 790}
10 Cable 50 ! 133 , 600
11 Phone % 100 . l 2 0 3 432
12 'Expense Total 2,834 0 L = L 36.112f
:i ‘ Rent Savings crf,zu pdycy:lenl MS:},',‘I' Electric nm;.m- Cell Cable Phone
:g J | Budget 595 400 750 269 350 87 135 62 50 36
7 Expense Type
18| A e e ‘®~——W—— o

A. ChartTitle

C. Data Labels E. Data Table

B. Legend

D. Horizontal Axis Title | F. Vertical Axis Title
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) Sparklines

Sparklines are miniature charts contained in a single cell. These micro-charts help visually analyze single data sets.
(Excel 2010 and later)

Formulas Data Review View Q@ Tell me what you want to do

File Home Page Layout

] 1 mm PN = il- I e~ u 1 }Z Line
—? - * l ? Yy~ II;v i I Ir%\‘ ' T Column
PivotTable Recommended Table [llustrations Add-  Recommended = ) \ll‘ PivotChart 3D ) Filters
PivotTables g ins ~ Chats @~ k- 3k~ Map - | F=Win/loss) -
Tables Charts = Tours Sparklines
Insert a Sparkline into your workbook: }
P y bo Create Sparklines ? X
1. Select the data range you wish to chart.
. Choose the data that you want
2. Click the Insert tab. T e
Data Range: ‘A1:ES| %z

3. Under the Sparklines section [A], select Line, Column, or

Win/Loss to open the Create Sparklines dialog box. The

. . Choase where you want the sparklines to be placed
range you selected will already be filled in the Data Range ———

|
i

feld. Location Range: | SFST:SFSS ERs
4. Click on the cell(s) where you want the Sparkline to e
appear and click OK. | eaneet
Line Column
A B c D | E F G | A B c | D E | F G
1] 600%  7.00% 10.00% -8.00%  4.00% — ’ 1] 6.00% 7.00% 10.00% -8.00%  4.00% =m® -
2[ -8.00% 5.00% -76.00% 25.00%  78.00% —_ 2:; -8.00% 5.00% -76.00% 25.00% 78.00% ——m—™
3|  6.00% 10.00% 25.00% -21.00% 18.00% — . 3| 6.00% 10.00% 25.00% -21.00% 18.00% —=Su=
4 | 34.00% 12.00%  -4.00% 90.00%  32.00% - - AJ 34.00% 12.00%  -4.00% 90.00% 32.00% w__ M=
5| 5.00% -200%  4.00% -2.00%  1.00% 5| 5.00% -200%  4.00% -3.00%  1.00% M-
6 | 6 ‘
Win/Loss .
4.00%
A | B C D E F G 78.00% Cut
1] 600%  7.00% 10.00% -8.00%  4.00% TE=,= IO Lopy
2| -800% 5.00% -76.00% 25.00% 78.00% m™wm™™ 20 FasteOptns
3| 6.00% 10.00% 25.00% -21.00% 18.00% @EE = T—— I
4| 34.00% 12.00% -4.00% 90.00% 32.00% W= gl
5| 500% -200% 4.00% -3.00%  1.00% "m™m™ D smart Lockup
6 f Insert...
’ Delete...
Clear Contents
To remove a Sparkline, right-click the cell that e T
contains a sparkline, select Sparklines, then Filte > Edit Single Sparkiine’s Date..
select Clear Selected Sparklines [B]. St gl
¥ Insert Comment 't Ungroup
[ Eormat Cells... & Clear Selected Sparklines
Pick Frem Drop-deown List... & Clear Selected Sparkline Groups
Define Name...
2 Hyperlink...
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There is nothing more frustrating than to work on a spreadsheet for a whole week, to format everything so it looks
perfect on the screen, only have it print incorrectly. There are several common printer errors that Excel
users encounter:

* Sheets that stretch across more pages than
intended

FedPryerSeminas 2 — O X

« Blank pages between missing pages

» Missing data
“Orphaned” rows and columns Printe 7 : *

Absent row headers or column labels on
subsequent pages

2 haria
Yo

it

Settings
z Print Active Sheets

* Missing or incorrect header/footer information

Preview before Printing:
1. Click the File tab.
2. Click the Print menu option [A].

3. Review the document in the Print Preview
Pane [B].

4. Click the back arrow to return to the document, or print directly from this view.

1 lef2 » o

Set the Print Area:
1. Select the cells to be printed.
2. On the Page Layout tab, in the Page Setup group, click the Print Area button [C].

3. Select Set Print Area.

Home Insert Page Layout

Formulas G Data Review View Q Tell me what you want to do

:(?;Width: Automatic - Gridlines Headings r
J

1‘ ™ = =1 BRE =
@ HL‘} ID IE:%’ ),_] E‘S @ ¢ [|Height Automatic -~ [V View [V View

Margins Orientation Size  Print Breaks Background Print e N Arrange
. . I L. Titles 7 Scale: 100% - [ Print [ Print -
Themes Pag [fé‘ Set Print Area h o Scale to Fit ] Sheet Options [
Al v o £ Clear Print Area

Make Other Adjustments:
» Adjust the Margins.
» Change page Orientation.
» Adjust page Breaks.
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The Page Setup Dialog

—~

Click the Page Setup group dialog box launcher [D page 29]
for more options:

The Page Tab: Controls on this tab govern page orientation
and scaling.

Orientation determines whether a page prints as Portrait or
Landscape.

« Use Portrait for sheets that have more rows than columns.

« Use Landscape for sheets with more columns than rows.

Use page Scaling to adjust a worksheet that is a little too long
or wide to fit to a single page either horizontally or vertically.

« The Adjust Function: These settings convert the page to a
percentage of its original size.

« The Fit to Function: These settings fit the printed document
to X pages wide by Y pages tall.

The Header/Footer Tab:

These functions control the inclusion of the date, a company
name, and any other information at the top or bottom of each

page.

Clicking the dropdown arrow in the Header or Footer option
boxes will reveal suggestions. If none of the suggested options
are appropriate, click Custom Header or Custom Footer.

The Sheet Tab:

The features on this tab are exceptionally helpful when print-
ing lists, as they configure header rows to print on every page.
Use the Rows to repeat at top section to enable this formatting.
Turn on the printing of Gridlines, Row and column headings,
Comments, and Cell errors as using the checkboxes in the Print
section of the tab.

30

Page Setup

Page Margins  Header/Footer  Sheet
Orientation

O portrait @®Landscape
Scaling

O Adjustto: 100 '3 = normal size

® Fitto: 1 < page(s) wide by 1 < tall
Paper size: Letter
Print quality: 600 dpi

First page number  Auta

Print...

Print Preview

Options...

Cancel

Page Setup

Page Margins  Header/Footer  Sheet

Header

(none)
Custom Header...

Footer:

(nonej

i\ 1
Page 1
Page 1 of 7

p.25 -26

Confidential, 10/9/2017, Page |
X7 Class File - TC2017Update

Custom Footer..,

R T T A S

A

[J pitferent first page
Scale with document
Align with page margins
Print...

Print Preview

Options...

Cancel

Page Setup

Page Margins  Header/Faoter Sheet

Print area:  SaS1:SNS12
Print titles
Rows to repeat at top. sts1
Columns to repeat at left:
Print
Qndlln-_‘i
[IBlack and white
[ Draft quality
[[] Row and column headings

Page order

® Down, then over

‘:' Qver, then down

Print...

Comments: (None}

Cell errors as:  displayed

Print Preview

Options...

Cancel
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Macros

What is a Macro?

A macro is a recording of commands - keystrokes and mouse clicks - that can be played back at any time. Any
repetitive set of tasks that are performed exactly the same way every time is a good candidate for becoming
a macro. For example, if the same report is generated weekly and must be printed using the same layout and
settings each time, recording those steps as a macro will speed up the process and minimize errors.

Create a Macro:
1. On the View tab, in the Macros group, click the Macros dropdown arrow and select Record Macro [A].

File Home Insert Page Layout Formulas Data Review . Q Tell mewhat you want to do
i = Wi " i ™
Ho B Page Layout Ruler |v! Formula Bar Q§, [\:’ @ = h‘lew ..’m'dow E Srfht oo LCE T
£ = Arrange All ;- Hide .
Normal Page Break (= ... Views [V Gridlines [ Headings Zoom 100% Zoom to B Switch Macros
Preview Selection LZ-] Freeze Panes - vnnide : Windows ~ v
Workbook Views Show Zoom Window :,‘T View Macros @
£20 - fe 29 Record Macro...
Use Relative References
A | B C D | E F __G___ H | | J K L [ M N i S e S
2. Inthe Macro name field [B], provide a descriptive name | Record Macro 7 X
for the macro.
i Macro name: 0
3. Assign a Shortcut key to the macro [C]. EeE & ]
| |
4. Click the OK button. ShGHiC ke KCD
5. Designate where the macro should be stored in the Ctri=| |
Store macro in dropdown [D]. Sore nacra e @)\
6. Provide a brief description and a date in the | This Workbook M
Description box [E]. Description: B -
7. Click the OK button. f x® ;
8. Perform the commands to be included in the macro. 1 ‘
‘ ]
9. On the View tab, in the Macros group, click the Macros e
dropdown arrow and select Stop Recording [F]. ~ Cancel |

3 2i0mas

Macros
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Appendix

Unassigned Keystrokes

The following keystroke combinations are not assigned to any default functlons by Microsoft in Excel. That makes
them good choices when assigning keystrokes to your macros.

Ctrl Commands Alt Commands Ctrl + Shift Commands

CTRL +j Alt+c Ctrl + Shift + c
CTRL+m Alt+d Ctrl + Shift +d
CTRL+q Alt+e Ctrl + Shift + e
Alt+g Ctrl + Shift+ g

Alt+h Ctrl + Shift + h

Alt +i Ctrl + Shift + i

Alt +]j Ctrl + Shift + j

Alt + k Ctrl + Shift + k

Alt+m Ctrl + Shift + m

Alt+n Ctrl + Shift + n

Alt+r Ctrl + Shift + g

Alt+s Ctrl + Shift +r

Alt+v Ctrl + Shift+ s

Alt +w Ctrl + Shift + v

Alt + x Ctrl + Shift + w

Alt+vy Ctrl + Shift + x

Alt +z Ctrl + Shift +y

Ctrl + Shift + z
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Compeatibility Between Excel Versions

Most, but not all, of Excel’s features are backwards
compatible from Excel 2007-2016/365. As a rule of
thumb, you can generally open files saved in older
versions of Excel with newer versions, but you might
not be able to use newer files in older versions.

New features (such as new functions and charts) in
particular may give you problems if you try to open
them in older versions such as this one to the right.

Files created in a version of Excel older than 2007
may need to go through the following conversion
process.

1. Click the File tab.

Select Convert [A] from the Info menu option.
(The Convert option will only be visible if the file
was created and saved in a version of Excel older
than 2007.)

3. Click OK to accept the warning about converting
workbooks, if it appears.

Browse to the location you wish to save the
converted file, type a file name, and click Save.

4.

Or, you can also use Save As and choose Excel

Workbook (*.xIsx) from the file type dropdown menu.

To save a workbook as a pre-2007 version, use the
Save As option and select Excel 97-2003 Workbook
*xls) from the file type dropdown menu. A dialog
box will pop up with information about what will
be lost.

LF\!I’D/// g 3
~ o~ Ifyou convertaworkbook to another version (in

‘2./ ' either direction), it will no longer be available in the
original file format. Make sure to keep a copy of the
ﬂ workbook in the original file format as a backup.

Ready | 7]

- RE s veaterfall chart - Microsoft Excel non-commeraial use

Inset  Pagelsyout  Formufas  Dats  Review Developer Format
ge Brezn Freview - o o= == S 0 (O e | o0 on s
G g o 1]
g gean v | .y € 2
Show o . Save Switth  Maaos
* ePanes * [ 22 workspace Windows = -
v ~ ind tacros
| Rectangle1 - fe
| A 8 C o E F G H ! J K L A
) I | | [ | | | s
| Thischart isn'tavailable inyour version of Excel. % 2 [3
E - 4
2 g 2
Editingthisshape or saving this workbookinto a difterent file format vaill 3 - S
“| permanently braak the chart. 595 595 795

L P PR P,

==

26|

2 714] 1095

LI CYIN] pa5:26 £ FJ.
Sum: 77892

Average: 5445993007 Count: 157

waterall chart [Compatibility Made] - Excel Fred Pryor Semminars -
all chart
(<3
£ ~ompatibility Mode Properties -
X Some disabled to Size
Convert Title
Tags
Categories

Related Dates

Last Medified

ypes of changes Created
people can make ta this warkbook

Lazt Printed

N
? AN

Microseft Excel - Compatibility Checker

The following features in this workbook are not supported by earlier
versions of Excel. These features may be lost or degraded when you save

@ this workbook in the currently selected file format. Click Continue to
save the workbook anyway. To keep all of your features, click Cancel and
then save the file in one of the new file formats.

Summary Occurrences
Minor loss of fidelity !
Some formulas in this workbook are linked to 7
other workbooks that are closed, When these Help

formulas are recalculated in earlier versions of Excel
without opening the linked workbooks, characters
beyond the 255-character limit cannot be returned.
Location: Defined Names

Excel 87-2003

Check compatibility when saving this workboak.
Copy to New Sheet Cancel

©Pryor Learning Solutions « WX71802ES

33



MICROSOFT EXCEL - THE BASICS

/% Appendix

Data Forms

Data forms are a useful way to find and enter records into a database that is very long or very wide. The Data Form
button, however, is not included in Excel’s default Ribbon. You can access it in one of two ways:

1. Add the command to the Quick Access Toolbar (See Also: Customize the Excel Environment). The command is
located under “Commands Not in the Ribbon” dropdown menu of Excel Options.

E@—‘E Customize the Quick Access Toolbar.

LCheese commiands from:

Page Layout Formulas

Cammands Mot in the Ribben v

Once the command appears in the QAT, select the Q data forml

range you wish to search or expand, then click the Form

command button. (5] Form
Feport Layout »
Murber Format 3
2. Windows Excel 2016/365 Only: Select the range you Accouning Nusrber Formats

wish to search or expand, then type “Data Form”into
the Tell me what you want to do searchbox, then select
Form from the results menu.

Formula Auditing Mede

Get Help on "data form”

© O E

Smart Leckup on "data form”

Emplolyee Info (2) ? X
Use the Data Form -
i . Employee Mumber: 100054 A 1of 13
 Type in any field to update the record. (Click Restore to f— : e
Lasti 3 | Brow W
erase your changes.) asiame 0 ——
. . FirstMame: Angela Delete
« Find Prev or Find Next to advance through the records '
Benefits: Self

in your sheet.

) . Hire Date: 3/6/2009
» Click New to enter a new record into your sheet.
AnnualSalary: 47000
» Click Criteria to enter search terms for specific records Separigenk Frerrr Find fext
you want to find. h Criteria

Close
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Freeze Panes

Freeze panes:

1. Clickin the cell beneath the row and/or to

the right of the column to be frozen. Review [RICUNN © Tell me what youwant to do
. . - C T ) .
2. On the View tab, in the Window group, O\ [’; qu £ New Window Split O EEJ D
i == Arrange Al T Hide (o
click the Freeze Panes dropdown arrow and oum 100%. Zoom 5 |12 P0G e 2 it Mases
select Freeze Panes [A]. Selection L= Freeze Panes - | ,@* Windows= =
P . " Zoom Freeze Panes
Hint! For a QUICk way to fI'EEZEJUSt the top E] Keep rows and columns visible while the rest of
row OrJUSt the leftmost column, choose tion o the worksheet scrells (based on current selection).
Freeze Top Row or Freeze First Column from Freeze Top Row A _
the Freeze Panes dropdown menu E D Keep the top row visible while scrolling threugh
. the rest of the werksheet, -—

64 S 21]988 Freeze First Column
Keep the first column wisible while scrolling =
S 078991

through the rest of the werksheet,

Q Tell me what you want to do

Unfreeze panes:

1. Clickin the cell beneath the row and/or to 5 ‘l CE NewWindow [Espit [0 [0 =
o e, | T
the right of the column to frozen. Q‘ Em Q H Arange Al T Hide =

Zoom 100% Zoomto — - " T Switch Macros
2. On the View tab, in the Window group, Selection =) Freeze Panes~ " Unhids indows~ -
click the Freeze Panes dropdown arrow and Zoom Hntreese Fanes gt ghasers
I Unf P B E Unlock all rews and columns to scroll
select Unfreeze Panes [B]. tion i through the entire worksheet. h

Freeze Top Row

E == Keep the top row visible while screlling G

through the rest of the werksheet, [O———
64 S 21[988 Freeze First Column
[j Keep the first celumn vizible while I
80 S 17’399 T screlling through the rest of the worksheet.
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Split Workbooks

Split a workbook into two windows:

1. On the View tab, in the Window group, click the Split button [A].
2. Click and drag the divider [B] to the appropriate position.

3. Click the Split button again to remove the split.

File Home Insert Page Layout Formulas Data Review

. [) Page Layout Ruler /! Formula Bar Q [:‘ Ed’ h r:]l Eﬁj
& =% [ Arrange Al " Hidel .
Normal Page Break ; S| Custorn Views 4] Gridlines 7 Headings Zoom 100% Zoomvto B Freeze P B} o .Svntch Macros
Preview Selection = E=iFreezeFanes~ | Windows - *
Workbook Views Show Zoom Window Macros ~
Al M S v
A B F . G H | _{ K I__ M B »N 797 R P . =
7
8 |Rent 595 595 595 595 595 595 595 595 595 7,140 595 |
9 |Taxes 1,130] 1.130] 1,130] 1,130] 1213 1213] 1213] 1213] 1213] 13,976 1,165
10 | Charity 452 452 452 452 485 485 485 485 485 5,580 466 |
11 |Savings 400 400 400 400 400 400 400 400| 2,000 6,400 533 |
12 | Credit Card 685 694 915 798 755 702 817 634| 1,164 9,397 733 |
13 {Car Payment 369 369 369 369 369 369 369 369 369 4,428 369 ‘
14 |Monthly Cash 280 360 520 320 360 280 300 340 380 4,140 345 |
15 |Electric 64 71 87 102 135 99 84 93 104 1,165 97 f
16 |Car Insurance 135 135 135 135 135 135 135 135 135 1,620 135 |
17 [Cell 62 62 62 76 62 87 62 62 62 790 656 [
6 | e
’ Err— ©) |
8 |Rent 595 595 595 595 595 595 595 595] 595 7,140 595 |
9 |Taxes 1,130] 1,130{ 1,130 1,130| 1213] 1213] 1213 1213] 1213] 13,976 1,165 I!
10 | Charity 452 452 452 452 485 485 485 485 485 5,590 466 |
11 |Savings 400 400 400 400 400 400 400 400 2,000 6,400 533 i
12 | Credit Card 685 694 915 798 755 702 817 634| 1,164 9,397 83 |
12 | Car Payment 369 369 369 369 369 369 369 369 369 4,428 369
14 |Monthly Cash 280 360 520 320 360 280 300 340 380 4,140 345
15 |Electric o 64 711 871 102  135] 99| 84 93 104 1.165 97 Ji~
4 » 4 4 »
Ready £ B m - —+ 1
Q““’R Si'?)

|ﬁ§,§ﬂ| Use the View Side by Side [C] button to compare two spreadsheets.
I}
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Add Pictures, Clip Art, and Shapes

Add a picture:
1. Click the Insert tab.
2. Choose an option from the lllustrations group:

a. Click Pictures to find images located on your
local hard drive.

b. Click Online Pictures to locate an image using
Bing Image Search.

3. Find and select a picture.
4. Click the Insert button.

31 Insert Picture X
“ = v T = ThisPC > Pictures » v O Search Pictures pal
Orgenize +  New folder - @
. Images o
_ Trainer's Guide 5

£31 Microsoft Excel

73 Dropbox

Camera Roll Mexico Project Saved Pictures Approved Lages
i@ OneDrive
[ This PC -
12 Desktop S
“ Documents KT RN

Picnic Graphic

§ vowiloids Vard Sale Graphic
b Music
= Pictures
H videos .
File name: | Anpictures v
Toals  ~ Insert |v|  Concel

Add a shape:
1. Click the Insert tab.

2. Click the Shapes dropdown arrow in the Illustrations
group.

3. Select a shape.

4. Click and drag to position it in your sheet.

5.

File Page Layout Formulas

PivotTable Recommended Table  Pictures Online

PivotTables Pictures @+ 7
Tables Ilustrations
B
by i iy .
Size -+ Type -  Color~  Creative Commons only v  Clear filters

PICNIC

what. nm,vm‘
bringing?

1ew the license to ensure you comply.  Show ail results

Select one or more items, Insent Cancel

DB W

Pictures Online Shapes SmartArt Screenshot

Pictures  ~ - - | M
Recently Used Shapes
BENWOOOALLLG
b ~n I b -,
A
Lines

LNTLL 29 N0 4%
Rectangles
OobhobonOoo
Basic Shapes

Block Arrows
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Add SmartArt

File Home Page Layout Formulas Data Review

" = FEz] = - e
Add a SmartArt diagram: E? i i ? 0~ |l:~
" PivotTable Recommended Table s Add-  Recommended
1. Cllck the Insert tab. PivotTables . insv Charts v, ¥ L ¥
2. Click the SmartArt button in the Illustrations B p— - b
group. s24 - o lLa &Y o
3. Selecta diagram type and style. ‘ | ‘ ) Pictures P(_Jr;line Shapes SmartArt Screenshot
i | ictures - ' N
4, Click OK. lllustrations [k
6
Choose a Smartart Graphic ? Pt
Y R A o |
Al e |
8 List {; = O@O EE ==
= SIC - = -
& Process [j—] SE)] lej -
2% Cucle ‘
W Cycle e = 5|
&By Hierarchy = (T e | i
= ==, = g |
E] Relationship ;
o 0— 00— |
% IMatrix = :l:—-::ﬁ_—:
é Pyramid e e
) o Alternating Hexagons
Fissars ELH ?/-_—] @ g-s-o- J-4G- Q- Use to represent a series of - ﬁ
B Office.com ! l_;_J =7 % L T interconnected ideas. Level 1 text appears ]‘
- = | inside the hexagans, Level 2 text appears ;
—_ — outside the shapes. i
- - [Oog J*
AEe [elel] OEE | »
=] [=][S] y JL |
[ok || cancet |
I ! K L M N (o} P Q R S
6 . & 5
77‘ Trpe yourtext here % 7 Y
r o [T
$$\ Iﬂq :0 o n..,.:' : 5
Use the Text Pane to enter your u | o ‘
text. Use the Design and Format B
tabs to modify the diagram. »

SmartArt Tools Fred Pryor Seminars

Design Format Q Tell me what you want to d

== 0 | e ee | e @s
[%:{? |D@ ; Change L L L L —/'} =
S B Colors~ e
Layouts SmartArt Styles
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' Group Data
. To group your data:

1. Select the rows you want to group under another row. In this example, the passengers using Alamo are going
to be grouped under Alamo.

2. Click the Data tab.
3. Click the Group button [A].

4.

Repeat for additional groups.

GHT/,
Sl

¥

File

E:

Get Exterl
Data ~

[+ ]

[+]

1

Home

Insert

Page Layout

Q Tell me what you want to do

% [} Show Queries ”—Eﬁ *, E]q[,j EJ B [?Q Group - _E
mFrom Table Reapply B8 * EH Ungroup ~ =
nal - New Refresh Textto What-If Forecast
Query - [ Recent Sources Al Yo Advanced  Colymns 55 - Analysis - Sheet £H subtotal
Get & Transform Connections Sort & Filter Data Tools Forecast Qutline M
b S Alamo
A B C D E F G H | J
1 DEPARTMENT TRAVEL EXPENSES
2 Vendor Passenger Name Depart | Return [ Tax  |Total Fare|
3_|AirTran Ainvays, Inc. SPEER STEPHEN 1202472016 . 840300  5403.00
4 |Alamo i
5 [Alamo _|Conelly, Doug 3/6/2016, 3/7/2016 $51.00 $51.00 ;
6 |Alamo Conelly, Doug 3/7/2016¢ 3/8/2016.  588.00 $63.00
7 |Alamo Conelly, Doug 4/17/2016 4/20/2016] 54839 '  $145.17
8 |/ Granowicz, Paula 1/27/2016: . 510.00 $27.00
9 | Hambleton, Rab 2124/2016 2/24/2016.  $41.00  $41.00
10 Hill, Vicki 2/27/2016 3/3/2016  $15.00  575.00 |
11[Alamo Hill, Vicki  13/27/2016/3/31/2016]  $4223 5168.92
12 |Robeits, Desmond 016 $26.74, $187.19
13 |Alamo Rocks, Julie 2/17/2016: 2/17/2016:  $415.50 5415.50
i e g Chl|eJuan . ; 55321 337250
16| America West Ailines —_|Dulla, Katie 8/16/2016 5192016, $123.06 | $369.19
(lick the Collapse or Expand buttons to geta
high-level or a detailed view of your data.
A | B | C i D | E F
1 DEPARTMENT TRAVEL EXPENSES
2 Vendor Passenger Name Depart | Return Tax _ |Total Fare
3 |AirTran Ainvays, Inc. SPEER, STEPHEM 2/24/2016 5403.00 5403.00
4 |Alamo
MZAmerica West Airlines
4UARC
166|Budget Newell, Patricia 1/27/2016: 1/30/2016 524 99 574.97
167|Continental Airlines
182|COURTYARD BY MARRIOTT [Conelly, Doug 3/6/2016: 3/7/2016 574.00 $75.00
183|Delta Air Lines Adams. Donna 5/16/2016: 5/20/2016;  $113.87 $569.36
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Appendix

Embedding Excel Spreadsheets into Word or PowerPoint
In Excel:

1. Select the cells you want to be copied.

2. Click the Copy button.

In Word or PowerPoint:

1. Click in the document where the selected cells should be inserted.
2. Click the Paste dropdown arrow.
3. Select Paste Special.
4. Select Microsoft Office Excel Worksheet Object.
5. Choose Paste or Paste link.
6. Click OK.
Document4 - Word Fred Pryor Seminars [ (| X
Design  layout  References  Mailings  Review  View  ACROBAT Q Tellme g_ Share
o Calibri (Body) JLUIE=RE A1 oenn BN o
‘:L B I U ~abe X, x? ’D § Paste Special ? X
Paste " i =\ g
- ~ AR g A -~ Aa~ A A .4 Source: Microsoft Excel Worksheet (code)
Group Data!R1C1:R182C6
Paste Options: I R ~
As:

s s Oa Oa W D e . . i

T4 = 4 = @ paste: [ bisplay as icon

s Opstesn [romated ot )

Paste Special... Bitmap
h Picture (Enhanced Metafile)
Set Default Paste.., HTML Format
Unformatted Unicode Text
Result
) Inserts the contents of the Clipboard into your document so that you can edit it using
|

Follow the same basic procedure for working with a chart. Just select
Microsoft Office Excel Chart Object in the dialog box in Word, or
Microsoft Office Graphic Object in PowerPoint.

40 ©Pryor Learning Solutions - WX71802ES



MICROSOFT EXCEL - THE BASICS

Appendix

If you have used the computer for any longer than one day, you've certainly been stuck before. There is nothing

more frustrating than to not know how to do something! Fortunately, there are different ways to get HELP!

Use Microsoft Help:

Excel 2007-2013
1. Click the Help button.

2. Type a topic in the Search field.

Excel 2016/365

1. Type a topicin the Tell me
what you want to do search
field.

2. Choose a result or click Get
Help on“keword” to open
the Help dialog.

Your ultimate goal is to work
smarter and NOT harder!

o® Mm%

Split Window

Convert Text te Table

Merge »
Get Help on "split" [:}

Smart Lockup on "split"

Excel 2016 Help

[CEOKA) 1Search

Results for "split”

Split text into different columns with the Convert Text to ...

Select the cells in your workbook where you wanl to paste your
split data. For example, if you are dividing a full name into a first
name column and a last name column, select the appropriate
number of cells in twao adjacent columns. Click the button to
expand the dialog box. and then click Finish.

Split text into different columns with functions - Office ...

Split text into different columns with functions. ... You can also
split text into different columns with ... Copy the cells in the table
and paste into an Excel ...

Split a cell

Split the content from one cell into two or more cells in Excel 2013
or Excel 2016.

“1
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Appendix

Books
QuickClicks: Excel by CareerTrack
Illustrated reference guides that answer your spreadsheet questions and walk you through every click.
QuickClicks: Excel 2007
QuickClicks: Excel 2010*
QuickClicks: Excel 2013*
QuickClicks: Excel 2016*
*Also in Downloadable eBook format!

QuickClicks Office Reference Guides by CareerTrack
lllustrated reference guides for Excel, Microsoft Access, Word, PowerPoint and Outlook. Sold individually and in
bundles.

QuickClicks Office 2010 Collection

QuickClicks Office 2013 5 Pack

QuickClicks Office 2016 5 Pack

CD-ROMs
Unlocking the Secrets of Microsoft Excel by CareerTrack
A unique “show-me, try-me” approach provides interactive practices that allow you the opportunity to experience
new skills in a safe learning environment.
Unlocking the Secrets of Microsoft Excel: Course 1 - Excel Basics
Unlocking the Secrets of Microsoft Excel: Course 2 — Beyond the Basics
Unlocking the Secrets of Microsoft Excel: Course 3 - Power Excel
Unlocking the Secrets of Microsoft Excel: Shortcuts, Tips, and Tricks
Unlocking the Secrets of Microsoft Excel: Formulas 1
Unlocking the Secrets of Microsoft Excel: Formulas 2
Unlocking the Secrets of Microsoft Excel: Macros
Unlocking the Secrets of Microsoft Excel: PivotTables

Unlocking the Secrets of Microsoft Suite by CareerTrack
Learn how to set up Microsoft Office applications to meet your personal needs at work or at home.
Unlocking the Secrets of Microsoft PowerPoint
Unlocking the Secrets of Microsoft Outlook
Unlocking the Secrets of Microsoft Access
Unlocking the Secrets of Microsoft Word
Unlocking the Secrets of Microsoft Excel

Budgeting & Finance Templates by CareerTrack
Interactive training program for Managers, Supervisors, and Business Owners using a business budget template.

Templates for Today’s Time-Crunched Professional by CareerTrack
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Improve efficiency with time management training.

Software
ConceptDraw® Office 3 Project Management Software
ConceptDraw Office is an innovative, comprehensive, and integrated project management software package
that helps you achieve your business and project goals. ConceptDraw Office will help you develop, manage, and
measure your projects with these three interactive tools:
ConceptDraw MINDMAP: Brainstorming and organization for ideas, data and processes (also sold individually).
ConceptDraw PROJECT: Comprehensive project management tool
ConceptDraw PRO: High-powered drawing and diagramming tool

Webinars
60 Minutes of Excel Secrets
Learn basic through advanced tips on how to get work done faster and easier in Excel.

Microsoft® Excel® Made Easy Series
Microsoft® Excel® Made Easy
Microsoft® Excel® PivotTables Made Easy
Microsoft® Excel® Charts and Graphs Made Easy
Microsoft® Excel® Forms & Reporting Made Easy
Microsoft® Excel® Formulas Made Easy
Microsoft® Excel® Macros Made Easy

Websites
Excel Tips and Tricks - http://www.pryor.com/blog/category/excel/
Read interesting blog articles and tips to get the most out of Excel.

Microsoft Official Help Pages - https://support.office.com/en-US/Excel
Read articles, search topics, view training videos, or contact a support technician (via chat).

Microsoft Training Center - https://support.office.com/en-us/office-training-center/Excel-tips
Read tips and find articles about Excel, written by the people that built it.

Excel Forum - https://www.excelforum.com/
Message boards for community questions and community-sourced answers about many Excel topics.

ExcelFunctions.net - http://www.excelfunctions.net/
Website created to provide help with Excel functions and formulas. Xﬂ)

\o

\DOW \ " \J\Ou} \IJJ&
O\'\ ? \,6(18 i R Q_Bc’a
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Getting Started
The Excel Window

0 Employeelnfo - Excel Fred PryorSeminars @ = O X

Insert Page Layout Formulas Data Review View Q Tell me what you want to do g Share

& ¥ . L e = = General - Kz Conditional Formatting - &= Insert ~ . - A
) Arial 12 A A TE= =€ = 97 &
6 Jt—j Em - ) . g - % v [_iFormat as Table - X Delete ~ SZI Fe&
aste HiL, My o vy === == free
Sox BIU- - L 2SS =2 €. (7 Cell Styles - EiFormat- & Fiers Selucts
Clipboard Font ™ Alignment rm Mumber 13 Styles Cells Editing -~
@ LA . B | € | D ™E | F | 6 | H | 1 4 4 K__ 1| _*
1| ‘
2 4
3 s
4 j
5
6 3
7 ?
8 | f
9 | i
10 ;
11 g
12 J i
13| !
14 |
15 A(© .
H » ] Emplolyee Info | Customer Payments ‘ Sheet2 ' Sheetd I e () 4 ) ) | ' r
* | ‘ e ] ‘ - =
Ready ' B mo- I +  100%
A The strip of buttons and icons above the work area.
B A collection of functionally- related controls and menus.
C An individual spreadsheet with rows & columns or a chart.
D A file containing multiple worksheets.
E Marks the currently active cell or range.
F Provides access to options such as open, save, print, etc.
G Stores shortcuts to frequently used features.
H Hosts specific shortcuts and information about a workbook.
| Controls the magnification of the screen.
J Launches the associated dialog box.
K Displays the contents of the currently active cell.
L Displays the name of the currently active cell.
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Design and Build

Five things that can go in an Excel worksheet:

1. ———— S I o S I
v N ——— = . . B
3. o o —_— — IE—
4, R o I B A L
5. == . L . -
Use the AutoFill Handle 1st Qtr Monday 9/1/2017|January
Use AutoFill to quickly copy one value to multiple cells 2nd Qtr  Tuesday 9/2/2017|January
or to populate adjacent cells with data series (such as 3rd Qtr  Wednesday : 9/3/2017|January
Dates, Days, Months). 4th Qtr Thursday 9/4/2017|January
1st Qtr Friday 9/5/2017))anvary |
PowerUser Tip: For more fill options, click the AutofFill

Copy Cells

Options dropdown arrow [A].

O Fill Series

O Fill Formatting Only

O Fill Without Fermatting

O Fill Months

O FElashFill

Select cells, columns and rows:

Useful Keyboard Shortcuts:

Cut» Ctrl +

Copy » Ctrl +

Paste » Ctrl +

Undo » Ctrl +

Redo » Ctrl +

©Pryor Learning Solutions = HX71807B 3
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Formulas

Data calculation and analysis are the primary reasons to use Microsoft Excel. Formulas are a key element in effective
calculation.

Rule #1: All formulas must begin with an equal sign (=).

Rule #2: Math in formulas is carried out left to right according to the “Order of Operations”

I

H I
L Parentheses ‘ 0 ; (3+2) 1O 1
5 Exponents A ‘ 3N2=9
J Multlpllcatlon ‘ * | 3%2=6 '1
; Division ‘ / ‘ -
" Addltlon ‘ + 3+2=5 } ;
[ .| T o - B T
{ Subtractlon z - 3-2=] ‘ “
! Which is the correct answer? ‘
‘ =5+6*10 ‘
| 110 or 65 '
Cells in Formula
e A B C
o Column references are always letters 1 | Tax Rate l 8 25% |
 Row references are always numbers 2
Trv It 3 Prices Shipping Total
e 4 $12.00 $2.00
Create a formula in cell C4 that calculates the total 5 $15.00 $3.00
price for each item, including tax and shipping. 6 | $18.00 $4.00
the:. Only apply the tax to the item price, not to the 7 $25.00 $5.00
shipping. 8

Formula:

Relative VS. Absolute Referencing

* Relative cell references adjust to the new row or column when a formula is copied.

* Absolute cell references use the $ symbol to prevent a formula from adjusting cell references when copied. A $ may be
applied to either or both components of a cell reference: $B1 B$1 $B$1 Which cell in our example should use absolute

cell references?

©Pryor Learning Solutions -«
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Functions
Think of functions as task-based, pre-programmed formulas. Functions are always formatted as follows:

=FunctionName(arguments)

SUM - X v f =SUM(E2HZ)

| A . B ‘ SUM(number?, [numberd], ...) E
I | ) | | | -

Create a Summary Sheet:
In this example, we need to add all four quarters for each state.

B C D E F G B cC D B
3 First Quarter Sales 3 | Year End Summary
4 January February March otal Sale \
5 | California | $1,345.00 | $2,345.00 | $4,567.00 $8,257.00 5 j California
6 Florida $3,333.00 | $3,456.00 | $6,443.00 $13,232.00 6 Florida
7 | Georgia | $2,356.00 | $7,665.00 | $9,999.00 $20,020.00 7 j Georgia
g | Indiana | $4,000.00 | $4,444.00 | $5,555.00 $13,999.00 8 | Indiana
’Jﬁiwféumﬁmaiyﬂ First Quarter | Second Quarter | Third Quarter | Fourth Quarter | - » | Summary | FirstQuarter | Second Quarter |

For California’s total, we could write:
='First Quarter’!F5+'Second Quarter’!F5+'Third Quarter’!F5+‘Fourth Quarter’IF5

1. Circle each complete cell reference in the formula
2. Draw a line from the cell reference in the formula to the source worksheet

3. Circle the cell in the Summary worksheet where the formula will be placed.

Using 3D Referencing, we get this: =SUM(‘First Quarter:Fourth Quarter’!F5)

©Pryor Learning Solutions » HX71807B 5
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Report

Organize and Display Data
Data formatted as a list are easy to read and understand, making that formatting choice ideal for reports.

7 Habits of Effective Lists:

5 Use formattlng to hlghllght portlons of the data.

1. Always create a Header Row

\
l — — e e — e
\ 2. Format the headerrow so it is ea5|ly dlstmgwshable

 from the rest of the data. - 6. Do not merge cells within the list.

| 3. Always build the list from top to bottom, not from \ 7. Be consistent — always use Delaware or always use DE, \

L
|

\ left to right. not a mix of the two.

1

|

4, Do not include any entnrely blank rows or columns in
| the data.

Circle all of the things that need to be changed to correct this example:

A B » ~C D __E F ) G
1 Ryan John 29 W. Corinthians Way  Tarpon Springs  Delaware 24394  913-834-2459
2 Ballard Richard 8305 Ruth Dr. SE Clearwater PA 78667 (215) 733-6778
3 Wilmot Robb 432 Ephesians Blvd. Daman FL 34698 (727) 987-4445
4 Lindt Doug 316 Luke Circle Phoenix AZ 18323 (459) 525-2945
5 Prindle Sherry 235 Genesis Court Mobile AL 13924 (290) 733-7727
6 Vickers Mark 112 Matthew Rd. Safety Harbor LA 46688 (395) 785-6667
7
8 Perkins Joe 349 W. Sampson St. San Francisco CA 43733 (656) 545-2345
9 Muhammad Rodney 7 Kings Hwy. Orlando FL 34688 (843) 734-9995
10 Karklins Maris 443 Titus Ave. Pearly Gates OH 56932 (909) 334-8721
11 Rock Chris 31 Proverbs Place Virtuous Bay MA 09732 (507) 288-3235
Chart Terminology
- 0D HE Fred Pryor Seminars
File Home  Inset  Pagelayout Data Format - Q Tell me what you want to do
L ome b : LE = m o
.\ﬂ!cﬁm ik Ch;r.gc |I|”:'-- il bl Iil“ ----- Ii'_i." i <v1|;}:RL‘ Select crmage i.me A
il T e a
Chart 2 " B.
A B [ E F L M N o]
z I i ( 1 | (£

R

7o C,

<
1 -
2 Rent ~ T a0
3 Savings 6,400
4 Credil Card 9,397 D.
S Car Payment 4,428]
6 Monihly Cash 4,140

Eleciii 1:.:I1ssj
; C:rlr[)lscumnce 1,620f E
9 Cell 790 ’
10 Cable 600
11 Phone 50 3€ 432
12 'Expense Tolal = - 36.112]
13 Phe F'
14
15 ) 36
16
17
18
©Pryor Learning Solutions « HX718078
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Macros
What is a Macro?

Any repetitive set of tasks that are performed exactly the same way every time is a good candidate for becoming a macro.
For example:

* A report is generated weekly and must be printed using the same layout and settings each time.

* You receive a weekly spreadsheet exported from an external source and you must adjust the data (such as changing
the order and names of columns) each time to align it with your format standards.

* You apply a standardized header and footer and company logo to each spreadsheet you produce

* You apply a custom formula to raw data received from an external source.

What repetitive tasks do you perform regularly?

©Pryor Learning Solutions « HX71807B 7
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Host a Lunch & Learn

Keep the momentum going with a Lunch and Learn “hosted” by Pryor Learning Solutions. Here is a guide to plan and execute
an hour-long, self-guided session. Topic ideas include Excel skills that reinforce and compliment the Excel-The Basics seminar.

Plan
A successful Lunch and Learn takes foresight and planning. Here are some basic steps you'll want to take:
» Schedule a time and reserve a room and any appropriate equipment needed (such as a computer or video display
equipment).
» Finalize details: caterer (if wanted), simple drinks such as coffee and water if attendees will bring their own lunches,
budget, topic, incentives if appropriate.

+ Promote - Send invitations, “advertise” the event in appropriate communications channels, collect reservations, etc.

Send reminders day before and day of event.

Have a little fun - If your work environment is amenable, think about lunch items or activities that fit the “theme” of
your topic. Example: Going over formulas? Invite attendees to bring their favorite recipe and then note how building a
formula using functions is similar to following a recipe.

Bonus - Pro Tips
» Hot Tips From Your Team: Ask everyone to bring their favorite Excel shortcut to share.

« Most Useful Functions: Introduce 3-5 of the most common and most used Excel functions with examples of how they
are used. Have attendees vote on the ones they would like to learn!

» Excel Shortcuts: Introduce several of Excel’s most useful shortcuts — both keyboard and via the Excel Ul.

» Chart Design: Find an expert or a skilled designer in your community to talk about the design aspects of creating
impactful charts and graphs. Emphasize skills such as compatible colors, fonts, and layout over Excel steps.

Explore More with Pryor
Microsoft Excel Made Easy - Get familiar with the basics: functions, formulas, commands and more.

Microsoft Excel Formulas Made Easy - Easily automate calculations and tasks to increase efficiency with basic and
advanced Excel formulas.

60 Minutes of Microsoft Excel Secrets — Learn to customize, organize and format your spreadsheets with ease.

©Pryor Learning Solutions « HX71807C 2
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Cut & Save

Get the Most Out of Your Seminar

Here are several exercises to help you solidify and retain the skills taught in Excel-The Basics. After a good night's sleep, you'll
be ready to hit your desk and try out what you've learned. Refer to your pre-seminar workbook to remind you of your goals
and the challenges you identified as most important.

Day After Seminar
» Find the pages in your digital seminar workbook that show your two to three highest priority tasks.
» Follow the steps in your workbook to perform each task on your own data.
e Print just those pages for you to keep beside your workstation as you incorporate the skills in to your daily work.

Week After Seminar

» Using the seminar workbook table of contents or your notes, make a list of 10 additional skills you wish to practice
and reinforce.

e Practice two skills each day.
» Open your digital seminar workbook to the skill and follow the steps to perform each task on your own data.

Print only the pages for skills that you would like to incorporate into your daily work.

If needed, practice one or two high priority skills each day as well.

Month After Seminar

» Once you are comfortable with your highest priority skills, choose one or two “reach” skills with which you would like
to challenge yourself.

» When an opportunity presents itself to practice a reach skill during your work, set aside some extra time to complete
the task. For example: You may not usually use Sparklines in your monthly report, but give them a try this month!

 Optional challenge — work through the entire digital seminar workbook, front to back, and quickly apply each skill to
a practice worksheet of your own data. If you can recognize and complete at least 75% of the skills, you are ready for
Excel Beyond the Basics!

Be Patient! It may take you longer to complete your work as you incorporate new skills, but the time you are taking will be
worth it the next time the task comes up! Set aside learning time along with your work as an investment in YOU.

©Pryor Learning Solutions « HX71807C 3
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You May Also Like

Learning Experts recommend reinforcing new skills with practice and repetition. Listed here are several follow-up courses
available with Pryor+ that we recommend as a next step after Excel - The Basics.

Have Access to Pryort?

Here are some resources you may find helpful:
(these are all short 1 minute Online courses available on Pryor)

 Choose Which Part of Your Worksheet to Print in To learn more about Pryor+,
Microsoft® Excel® 2016 visit: pryor.com/unlimited-training/
¢ Insert a Chart in Microsoft® Excel® 2016

» Page Setup in Microsoft® Excel® 2016 } @4.@4.@4. @ = @D PRYOR |

» Record a Macro in Microsoft® Excel® 2016 sinins  mANNG  apwme
o Adjust Row Height and Column Width in Microsoft® Excel® = With over 4,500 Online courses and thousands of live z
2016 | seminars nationwide, the opportunities to learn are right

at your fingertips!
o Freeze and Unfreeze Columns and Rows in Microsoft® I .
Excel® 2016
o Hide and Unhide Columns and Rows in Microsoft® Excel® 2016
e |Insert a Basic Formula in Microsoft® Excel®2016

Insert a Basic Function in Microsoft® Excel®2016

Go Deeper

Excel® Basics Learning Path - Essential Excel Formulas and Functions for Beginners
Learn how to successfully set up and use basic Excel formulas and functions using these tips, tricks, and shortcuts.
Length: 1 hours 15 minutes

Excel® 2013 Part 1 Series
This series is a review of basic options and tools in Microsoft Excel 2013.

Microsoft® Excel® 2013 Basic
Software Training - eBook (downloadable PDF)

Excel Beyond the Basics (Y7) Seminar

Login to register, or if you you aren’t on Pryor+, visit pryor.com/unlimited-training/ to learn more.
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